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• generic media and gMovie are trademarks of generic media, inc.

• CLIE, PictureGear, Memory Stick and the Memory Stick logo are trademarks of Sony Corporation.

• Microsoft and Windows are registered trademarks of Microsoft Corporation.

• Graffiti, HotSync and Palm OS are registered trademarks, and Palm Desktop and the HotSync logo
are trademarks of Palm, Inc. or its subsidiaries.

QuickTime and the QuickTime logo are trademarks used under license. QuickTime is registered in the
U.S. and other countries.

All other trademarks are trademarks of their respective owners.

Before using this software, please read the Software License Agreement that is supplied with CLIE
handheld.

❒ Copying all or part of the contents of this software, sample images, and Operating Manual,

or renting the software are prohibited by copyright laws.

❒ The Company is not liable for damage or loss resulting from the use of this software, or for

any claim from a third party.

❒ The Company assumes no responsibility aside from the replacement of the media due to

manufacturing fault.

❒ This software must not be used in a system other than that specified.

❒ The software specifications may be subject to change without notice.
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Before Use

Features

gMovie is the add-on application which enables the display and
playback of motion picture data with sound, made for CLIE handheld by
using a Windows® application PictureGear Lite etc.

When you transmit movie data made for CLIE handheld by PictureGear
Lite to the CLIE handheld with HotSync operations, or copy them to the
CLIE handheld by using a Memory Stick, they are automatically
registered to the movie list of gMovie.

This Version (gMovie 1.2) supports playback of color movies with sound,
Jog Dial control, and playback of data stored in a Memory Stick.
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Basic Operations

Starting gMovie

Select gMovie from the Home screen of CLIE handheld by rotating
and pressing the Jog Dial.
The gMovie application starts and the media (movie file) list appears.
Motion pictures that you can playback with gMovie are called "media."

z If no media file is installed, no list is displayed. To create a media file,
refer to "Creating a media file for gMovie using PictureGear 4.3 Lite"
(page 12).

Tapping these buttons toggles the contents of switchable
information in four ways.

Switchable information : Tapping the following icon,
displays of contents change.

 : displays type of media item.

 : displays dimensions of media item (pixels).

Switchable information

[video] indicates the movie
without sound.
[audio + video] indicates the
movie   with sound.

Name of Media item

Media List
By rotating and pressing the Jog Dial
you can select and playback the
media.

Details

Movies stored in the Memory Stick
are indicated with the   icon.
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 : displays duration of media item (seconds).

If the media file has many frames per second, the
actual time duration may be longer than that
displayed.

 : displays storage requirements (KB).

  Details icon : Tap this buttons to display details of media.
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Playing back a media file

Select the media file you want to playback from the Home screen of
CLIE handheld by rotating and pressing the Jog Dial.
The media file is automatically played back.

Note
You can playback the media file using the stylus to tap it.

Control with the Jog Dial
Pause: Press the Jog Dial during playback.

Restart playing back: Press the Jog Dial during pause.

Scrolling still pictures: Rotate the Jog Dial during playback or pause.

Control with the stylus
Pause: Tap .

Restart playing back: Tap .

Rewind: Tap  to return to the beginning of the  media file.

By tapping the right side of the volume adjustment icon  , the sound
volume increases. By tapping the left side of the  icon, the sound
volume decreases.

Note

In normal playback mode, the playback of the same media file repeats.

Indicates the position of the playback
picture
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To return to the media list

Press the Jog Dial more than two seconds and release it.

Or tap  at the upper right corner of the display.

To playback the next media item

While pressing, rotate the Jog Dial downward during media item

playback. Or tap  at the upper right corner of the display.

To playback the previous media item

While pressing,rotate the Jog Dial upward during media item playback,

or tap the  in the upper right corner of the display.

To playback all media items consecutively (Sequence Play mode)

Press  more than one second with the stylus. In Sequence Play mode,
the icon will change into . To exit the Sequence Play mode, press

 more than one second.

To delete a media item

1 Display the media item to delete, then tap  icon.

2 Tap Delete.

3 Tap OK.
The media item will be deleted, and the display will return to the
media list.
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You can also use the remote controller of the headphone supplied
with the CLIE handheld to control the functions

 : go to next file

 : return to previous file

 : playback

 : stop

 : volume adjustment
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Miscellaneous

Menu Commands

Media menu

This menu is displayed by tapping  icon when the media list is being
displayed.

About gMovie

Version information of the gMovie application is displayed.

This menu is displayed by tapping  icon when a media item is being
displayed.

Details

Detailed information of active media item is displayed.

Beam Movie

You can transmit the data of active media item to another CLIE handheld
via the IR port. For details of infrared communication, see the Operating
Instructions manual of your CLIE handheld.

Note
It may take considerable time to complete infrared communication, depending on
the size of the media file.

Delete
You can delete the active media item. When the Delete Media dialog is
displayed, tap [OK] to perform deletion, or tap [Cancel] to cancel
deletion.
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Preferences
s Loop movie playback

When the playback of the media item is finished, the playback is
automatically stopped.

Note
If you de-select the check in this check box, you cannot automatically play

back next media item by pressing the  at the upper right corner of the

display. Start the playback pressing the .

s Limit Maximum volume

Limits the maximum volume of the stereo sound. You can set not to
playback the maximum volume level (the right edge of the indicator
on the screen) by tapping it or using the remote control.

Audio Channels:

In this dialog box you can select to playback the right side stereo
sound or left one and switch the playback from the right hand
headphone or left one.

Both: to playback the both side stereo sound from the both
headphones.

Left: to playback the left side stereo sound from the left headphone.

Right: to playback the right side stereo sound from the right
headphone.

Note
Right and Left cannot set to playback the either side stereo sound from the
both headphones.

About gMovie
Version information of the gMovie application is displayed.
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Creating a media file for gMovie using
PictureGear 4.3 Lite

You can create a media file for gMovie using PictureGear 4.3 Lite for
personal computers.

You can install PictureGear 4.3 Lite to your computer from the install
CD-ROM supplied with your CLIE handheld. For details on how to
install the application, refer to the instruction manual of your CLIE
handheld.

For details on how to use PictureGear 4.3 Lite, refer to the online help
“How to use PictureGear 4.3 Lite,” displayed by clicking the Help menu
of PictureGear 4.3 Lite.

The following explains how to send a media file created by PictureGear
4.3 Lite to your CLIE handheld.

Movie (media) file formats you can use with PictureGear 4.3 Lite

PictureGear 4.3 Lite supports the following movie file Formats:

• MPEG1 (file extension:  .MPG, .MPEG)

• AVI (file extension: .AVI)

• QuickTime 3.0 and QuickTime 4.0 (file extension: .MOV, .QT)

Note
When using gMovie on your CLIE Handheld, you may not be able to display
some AVI format files that do not conform to the Video for Windows standard.

Sending media files to a CLIE handheld using the HotSync
function

By resistering the media files you want to send in the PictureGear 4.3
Lite, as well as the recipients thereof, you can have HotSync send the
movie files automatically upon connection of the recipient’s CLIE
handheld to your computer.

1 Select the slide (movie file) you want to send.
Click on a slide to select it. You can select multiple slides by holding
down the Ctrl or Shift key while clicking.

2 Select [Output services] - [Install the image during the next
HotSync] from the [File] menu.
The [Reserve to install on next HotSync] dialog box appears.
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3 Click V and select the recipient’s user name from the drop
down list.
If necessary, click [Movie settings] and make size and compression
settings for the movie file(s) you want to send in the [Detailed
settings for CLIE handheld movies] dialog box.

About [Detailed settings for CLIE handheld movies] dialog box

[Select Compression Method]

Selects the grayscale or color level for the movie file(s) you want to
send. Click to select [Monochrome (High compression)],
[Monochrome (High image quality)], or [Color].

[Size]

Selects the dimention size of the movie file(s) you want to send.
Click to select [160 x 120], [120 x 90], or [80 x 60].

[Dithering]

When Monochrome (High compression) is selected in [Select
Compression Method], you can use this slider to adjust the dither
level by dragging it to the left or right. You cannot use this function
on the [Monochrome (High image quality)] and [Color] movies.

[Sound Quality]

Adjusts the sound quality for the movie files.
Click to select [None], [Low], [Middle] or [High].

z The larger the [Size] or [Sound Quality] is, the larger the
movie file size will be.

Note
If you select still image movie files, the [Settings for Still images] dialog box
appears.

4 Click [OK].
The selected movie files and their recipients are registered in
PictureGear 4.3 Lite.

5 Perform HotSync between a recipient’s CLIE handheld and
your PC.
The registered slide(s) are automatically sent to the recipient’s CLIE
handheld.
If the created movie file data is too large and exceeds the free
memory space of the CLIE handheld, an error message may appear
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during HotSync. To display a large size movie file using gMovie, try
using a Memory Stick, as follows.

Copying movie files to a Memory Stick

The following procedure explains how to copy slides (movie files) from
PictureGear 4.3 Lite to a Memory Stick, and to display them on a CLIE
handheld using gMovie.

1 Click to select the slide (media file) you want to display on a
CLIE handheld.
You can select multiple movie files by holding down the Ctrl or Shift
key while clicking.

2 Select [Output services] - [Output CLIE handheld format file(s)
to Memory Stick] from the [File] menu.
The [Output CLIE handheld format file(s) to Memory Stick] dialog
box appears.

3 Click V and select a Memory Stick drive from the drop down
list.
Note
For the drive name of the Memory Stick, refer to the instruction manual of
your personal computer.

If necessary, click [Movie settings] and make size and compression
settings for the movie file you want to send in the [Detailed settings
for CLIE handheld movies] dialog box.

About [Detailed settings for CLIE handheld movies] dialog box

[Select Compression Method]

Selects the grayscale or color level for the movie file(s) you want to
copy. Click to select [Monochrome (High compression)],
[Monochrome (High image quality)] or [Color].

[Size]

Selects the dimention size of the movie file(s) you want to copy.
Click to select [160 x 120], [120 x 90], or [80 x 60].

[Dithering]

When Monochrome (High compression) is selected in the [Select
Compression Method], you can use this slider to adjust the dither
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level by dragging it to the left or right. You cannot use this function
on the [Monochrome (High image quality)] and [Color] movies.

[Sound Quality]

Adjusts the sound quality for the movie files.
Click to select [None], [Low], [Middle] or [High].

z The larger the [Size] or [Sound Quality] is, the larger the
movie file size will be.

Note
If you select still image movie files, the [Settings for Still images] dialog box
appears.

4 Click [OK].
The movie files converted to gMovie format are copied to the
[\PALM\PROGRAMS\gMovie] folder in the Memory Stick.

5 Insert the Memory Stick into the CLIE handheld.
The movie files stored in the Memory Stick are automatically
displayed in the gMovie list.

Note
If the movie file data written to the Memory Stick is too large and exceeds the
free memory space of the CLIE Handheld, the error message “Data writing
failed” may appear. Reduce and rewrite the data by trying one of the
following procedures.

1 Change to grayscale (to cut data in half or less).

2 Reduce the movie size.

3 Reduce the sound quality.

When you create a movie file, you can confirm the data size by selecting the
drive on your PC, such as C:drive. After writing the data to your PC drive
[C:\PALM\PROGRAMS\gMovie] (when you select C:drive), copy the data
to the Memory Stick drive: [\PALM\PROGRAMS\gMovie] folder on the
Memory Stick, by using Explorer on your PC to display the movie file on the
CLIE handheld.
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